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March 31, 2011 — Got DATA? Protect IT!

The following is a list of locations where Microsoft Office Outlook 2007 saves information. Some of the folders might be
hidden folders. To display hidden folders, do the following:

Windows Vista
1. In Windows, click the Start button, and then click Control Panel.

2. Click Appearance and Personalization.

NOTE If you are using Control Panel Classic View, double-click Folder Options, and then continue with step 4.

3. Click Folder Options.

4, On the View tab, under Advanced settings, under Files and Folders, under Hidden files and folders,
select Show hidden files and folders.

Microsoft Windows XP

1. Click the Start button, and then click Control Panel.

2. Click Folder Options.

Folder Options

Wigw |

'[ | |

Advanced settings:

| Files and Folders ~
Automatically search for network folders and prinkers

|5 Hidden files and folders
3 Do not show hidden files and folders

Show hidden files and folders
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3. Click the View tab, and then click the Show hidden files and folders option.

Your configuration may not include all of the following files. Some files are created only when you customize Outlook
features.

Personal Folders file (.pst)

Personal Folders files (.pst) contain your e-mail messages, calendars, contacts, tasks, and notes. You must use Outlook to
work with the items in a .pst file.

When you archive Outlook information, items are saved in a .pst files.

NOTE Microsoft Exchange Server accounts store your information on the mail server. For Cached Exchange Mode or

to work offline, copies of your items are saved in an Offline Folders file (.ost). See the Offline Folders file (.ost) section
for more information. Also, some organizations allow you to export or archive your items to a .pst file.

Windows Vista drive:\Users\user\AppData\Local\Microsoft\Outlook

Microsoft Windows XP or Microsoft Windows Server 2003  drive:\Documents and Settings\user\Local
Settings\Application Data\Microsoft\Outlook

Personal Address Book (.pab)

Windows Vista drive:\Users\user\AppData\Local\Microsoft\Outlook

Windows XP or Windows Server 2003 drive:\Documents and Settings\user\Local Settings\Application
Data\Microsoft\Outlook

NOTE Personal Address Books (.pab) are no longer supported by Office Outlook 2007. When you upgrade to Office

Outlook 2007, you are prompted to import any .pab file into Contacts. If you choose not to import the .pab file, you can
import it later by using the Import and Export command on the File menu.

Offline Address Book (.oab)

The Office Address Book (.0ab) is used by Microsoft Exchange Server accounts. The Offline Address Book contains the
properties of a user, such as e-mail addresses, that Outlook requires in order to send an e-mail message and display
information about the user. By using the Offline Address Book, Outlook does not have to connect to Exchange in order
to resolve names or open the records for each user. This reduces network traffic and improves performance.

PRONETS ¢ 307 Meadow Street ® Galax, VA 24333 e Phone: 276-236-8226 or 888-544-7544 « www.pronetsinc.com
Page 2 of 7




PRONETS

ONE technology solution :

/

” ” =
fIY many asptil# Vs business
e

You do not need to back up or restore this file. This is file is created and updated by Outlook.
Windows Vista drive:\Users\user\AppData\Local\Microsoft\Outlook

Windows XP or Windows Server 2003  drive:\Documents and Settings\user\Local Settings\Application
Data\Microsoft\Outlook

Outlook Contacts AutoComplete (.nk2)

AutoComplete is a feature which displays suggestions for names and e-mail addresses as you begin to type them. These
suggestions are possible matches from a list of names and e-mail addresses that you have typed before, known as the
AutoComplete name list.

Windows Vista drive:\Users\user\AppData\Roaming\Microsoft\Outlook

Windows XP or Windows Server 2003  drive:\Documents and Settings\user\Application Data\Microsoft\Outlook

Signatures (.rtf, .txt, .htm)

Windows Vista drive:\Users\user\AppData\Roaming\Microsoft\Signatures

Windows XP or Windows Server 2003 drive:\Documents and Settings\user\Application Data\Microsoft\Signatures

Stationery (.htm)

Windows Vista drive:\Program Files\Common Files\Microsoft Shared\Stationery

Windows Vista 64-bit with Office Outlook 2007 32-bit drive:\Program Files (x86)\Common Files\Microsoft
Shared\Stationery

Windows XP or Windows Server 2003  drive:\Program Files\Common Files\Microsoft Shared\Stationery

Custom forms

Windows Vista drive:\Users\user\AppData\Local\Microsoft\Forms
Windows XP or Windows Server 2003  drive:\Documents and Settings\user\Local Settings\Application
Data\Microsoft\Forms
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Message (.msg, .htm, .rtf)

Windows Vista drive:\Users\user\Documents

Windows XP or Windows Server 2003  drive:\Documents and Settings\user\My Documents

How to get there: Start Button, All Programs, Accessories, System Tools, Backup
Follow the prompts.

Backup lets you back up data to a file or to a tape. When you back up data to a file, you have to designate a file name
and a location for the file to be saved. Backup files usually have the extension .bkf, but you can change it to any
extension. A backup file can be saved to a hard disk, a floppy disk, or to any other removable or nonremovable media on
which you can save a file.

When you back up data to a tape, you must have a tape device connected to your computer. Tapes are managed by
Removable Storage. Although Backup works together with Removable Storage, you might have to use Removable
Storage to perform certain maintenance tasks, such as preparing and ejecting tapes.

The following four steps describe a simple backup operation:

ESelect files, folders, and drives for backup
Backup provides you with a tree view of the drives, files, and folders that are on your computer, which you can use to
select the files and folders that you want to back up. You can use this tree view the same way you use Windows Explorer

to open drives and folders and select files.

ESelect storage media or file location for backed-up data

Backup provides two options for selecting storage media:

You can back up your data to a file on a storage device. A storage device can be a hard disk, a Zip disk, or any type of
removable or nonremovable media to which you can save a file. This option is always available.

You can back up your data to a tape device. This option is available only if you have a tape device installed on your
computer or connected to it. If you back up data to a tape device, the media will be managed by Removable Storage.

ESet backup options

Backup provides an Options dialog box, which you can use to customize your backup operations. Using the Options
dialog box, you can:
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Select the type of backup that you want to do. Backup types include: copy, daily, differential, incremental, and normal.

Select whether you want a log file to record your backup actions. If you select this option, you can also select whether
you want a complete log file or summary log file.

Select whether you want to back up data that is stored on mounted drives.
Designate file types that you want to exclude from a backup operation.
Select whether you want to verify that the data was backed up correctly.

EiStart the backup

When you start a backup operation, Backup will prompt you for information about the backup job and give you the
opportunity to set advanced backup options. After you have provided the information or changed your backup options,
Backup will start backing up the files and folders you selected.

If you have scheduled the backup to run unattended, you will still be prompted for information about the backup job.
However, after you have provided the information, Backup will not start backing up files; rather, it will add the
scheduled backup to the Task Scheduler.

[¥Notes

e You must be an administrator or a backup operator to back up all files and folders. If you are a member of the
Users or Power Users group, you must be the owner of the files and folders you want to back up, or you must
have one or more of the following permissions for the files and folders you want to back up: Read, Read and
Execute, Modify, or Full Control. For more information about permissions or user rights, click Related Topics.

e The registry, the directory service, and other key system components, are contained in the System State data.
You must back up the System State data if you want to back up these components.

e You can only back up the System State data on a local computer. You cannot back up the System State data on a
remote computer.

e You can schedule a backup so that it will run unattended at a specific time or frequency. You can schedule a
backup after you click Start Backup.

e If you have Windows Media Services running on your computer, and you want to back up the files associated
with these services, see "Running Backup with Windows Media Services" in the Windows Media Services online
documentation. You must follow the procedures outlined in the Windows Media Services online documentation
before you can back up or restore files associated with Windows Media Services.

e If you are using Removable Storage to manage media, or you are using Remote Storage to store data, you should
regularly back up the files that are in the following folders:

Systemroot\System32\Ntmsdata
Systemroot\System32\Remotestorage

This will ensure that all of your Remote Storage and Removable Storage data can be restored.
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To back up your files

1. Open Backup and Restore by clicking the Start button ﬁ, clicking Control Panel, clicking System and
Maintenance, and then clicking Backup and Restore.

2. Do one of the following:

o If you've never used Windows Backup before, click Set up backup, and then follow the steps in the
wizard. ¥ If you're prompted for an administrator password or confirmation, type the password or provide
confirmation.

o If you've created a backup before, you can wait for your regularly scheduled backup to occur, or you can
manually create a new backup by clicking Back up now. ¥ If you're prompted for an administrator password
or confirmation, type the password or provide confirmation.

_-Il—h I"\., L fl
Notes

. We recommend that you don't back up your files to the same hard disk that Windows is installed on.

. Always store media used for backups (external hard disks, DVDs, or CDs) in a secure place to prevent
unauthorized people from having access to your files—we recommend a fireproof location separate from your
computer. You might also consider encrypting the data on your backup.

To create a new, full backup

After you create your first backup, Windows Backup will add new or changed information to your subsequent backups. If
you're saving your backups on a hard drive or network location, Windows Backup will create a new, full backup for you
automatically when needed. If you're saving your backups on CDs or DVDs and can't find an existing backup disc, or if
you want to create a new backup of all of the files on your computer, you can create a full backup. Here's how to create
a full backup:

1. Open Backup and Restore by clicking the Start button ﬁ, clicking Control Panel, clicking System and
Maintenance, and then clicking Backup and Restore.

2. Inthe left pane, click Create new, full backup.
Note

You will only see this option if your backup is being saved on CDs or DVDs.
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To set up a backup after upgrading from a previous version of Windows

After you upgrade Windows, you will need to set up Windows Backup, even if you had a scheduled backup in the
previous version of Windows. This is because there are several changes to the backup program. Instead of selecting file
types to back up, you can have Windows back up data files saved in libraries, on the desktop, and in default Windows
folders, or you can choose specific libraries and folders to be backed up. You can also create a system image of your
computer. For more information, see How does Windows choose which files to back up?

To set up your backup, follow these steps:

1. Open Backup and Restore by clicking the Start button ] clicking Control Panel, clicking System and
Maintenance, and then clicking Backup and Restore.

2.  Click Set up backup, and then follow the steps in the wizard. ¥ If you're prompted for an administrator
password or confirmation, type the password or provide confirmation.

Provided as an educational service by:
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